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ELL Tech Recipe 

BLOGGING: TECHNOLOGY RECIPE FOR CREATING A BLOG 

Serves:  

English Learners at any level – the content is up to you, so you 
determine what will be of the most benefit to your students. 
Better yet, it’s interactive, so your students may respond, and 
it’s fun, which helps keep the affective filter at a manageable 
level.  

Ingredients: 

To create a blog you will need a computer with access to the 
Internet. A high-speed Internet connection is optimal. No 
special software or hardware aside from your basic computer is 
required. The more tech tools you have, the more things you can 
add to your blog, but a very nice blog may be created without 
any extras at all. 

A blog is like an interactive, dynamic Web page. You may include 
images that you want your students to respond to, slide shows, 
podcasts, online discussions, student writing, create a class 
publication, let students who were absent know what they missed, 
make announcements, even links to other sites, such as your 
online gradebook. Or you can keep it very simple and just have 
students respond to articles you post, or writing that you or 
they post.  

Directions for Cooking 

Go to a blogging website and sign up. You may find that 
edublogs.org is a particularly good site. Because it is safe 
for all users it is most likely that your school district’s 
tech department will be willing to open access to it. The 
website will walk you through creating your own blog. 

Other free blogs are listed below. The key is to choose one 
and get good at using it. They all are slightly different. 

Wordpress.com (EduBlogs uses Wordpress as its software, so 
if you can do one, you can do them both.) 
Blogspot.com 
Blogger.com 
Livejournal.com 



.mytypes.com 
 

Basically, the steps are as follows: 

1. Go to edublogs.org 

2. Sign up for the site. 

3. Go to “Start a blog” 

a. Register your domain (your own URL) for this blog. 

b. Give it a title (this can be changed) 

c. Decide on a privacy level 

i. Can search engines find it, or just people you 
invite? 

ii. You will want to be the Administrator and your 
students can be contributors or authors, 
depending on how much control you are willing to 
share. 

4. Click the tab “My Dashboards” 

5. First, decide on how you want your blog to look 

a. Click the “Presentation” tab 

i. Shop for a theme and select one. This is easily 
changed if you decide you don’t like it. 

ii. Decide on any widgets or extras you may want to 
add. (If you have chosen a one-column theme, you 
won’t be able to easily add any widgets or 
extras.) 

1. Examples of widgets: calendar, search bar, 
archives (old entries), recent comments, 
blogroll (links). There are many more 
available. 

iii. If you have digital photos on your computer you 
may want to choose a custom image header. The 
program will walk you through cropping your image 
to fit the size of the header of whatever theme 
you chose. 

6. Write your first post. You may want to introduce yourself, 
or the purpose of your blog. It’s up to you! 



a. Write, and then save. 

b. When you are ready, click “Publish” to have the entry 
appear in your blog. 

7. As you use your blog, you will become more adept at 
modifying it and adding new items. Just play with it a bit 
before you introduce it to your students, so you know what 
you can do with this technology and then have fun with it! 
It is a great way to create classroom community, and 
increase the connection between your students and their 
school experience. 

 

ELL Tech Recipe 
DIGITAL STORYTELLING USING PHOTO STORY 3 

 
Serves:  

Children as young as 6 or 7 have successfully produced digital stories 
(with assistance). English language learners, at any level, seem 
motivated and able to produce a simple digital story. Novice-level 
learners produce a simple script while highly proficient learners 
produce the digital story as a final project of a longer writing 
process. 

Ingredients: 

 Photo Story 3 downloaded on your PC computer 

 A computer microphone  

 A script, or written material that can be reduced to a script 

 A collection of digital images, either your own or from Internet 
sites. 

 

Directions for Cooking 

1. The first step in the process is to download the free software 
program available from Microsoft for PCs Window-based systems. Click 
on download and follow the instructions as prompted. 

http://www.microsoft.com/windowsxp/using/digitalphotography/photostory
/default.mspx 



 

2. After download is complete, look for the Photo Story icon on your 
desktop. It is put there automatically. Click on this icon and the 
program will open up.  

 

 

3. Click on the option, “Begin a new story.” 

 

Moving from Action to Action 

At the bottom of your screen are the major action buttons. “Back” and 
“Next” take you to the major action screens. These are the most 
important buttons. 

In the sample story below, I talk about my family’s immigrant voyage from Europe to New York City 
via Ellis Island. My students like hearing that my family, too, immigrated to America.  

 

First Action: Importing Pictures and Editing Pictures 



5. Importing Pics 

You can import pictures from a variety of sources. You can import pics 
from your photo file on your computer. You can scan in images from 
documents using a scanner, save these as files, and import into Photo 
Story. Or, you can get images from www.images.google.com or Yahoo or 
Microsoft images. Just do a search of a term, such as “classroom.”  

 

5. The TV Screen 

Inside the large frame is a TV screen–type frame. In each TV frame, 
you can manipulate pictures. For example on the “Import Pictures” 
frame, you can crop or cut your picture by clicking on the “edit” 
button. 

6. Moving Images around 

You can move from picture to picture by using the TV screen arrows or 
by clicking on the images themselves. You can also drag images into 
different places by clicking and dragging. 

 

Action Two: Adding Text to Your Images AND Changing Picture Effects 



 

7. Adding Text 

Using the text box on the right, you can add words to your images and 
change the size, color, and font of your words. 

8. Changing Picture Effects 

This is the jazzy stuff. You can change your image to sepia, 
watercolor, diffuse glow and a host of other effects. Just pull down 
the Effects menu. 

 

Action Three: Recording Voice and Customizing Motion and Transitions 

 

10. Recording Your Voice 

You will first need to make sure that you have a microphone hooked up 
to your computer (preferred) or that your computer has a microphone 



built in. Then, write your script in the text box on the right. When 
you are satisfied and have practiced a bit, click on the red dot above 
your script. Read into the microphone. When you are done, click on the 
smaller “Stop” square. Listen to what you said by clicking on the 
Preview button. If you like it, fine. If you are not satisfied with 
your recording, click on the backward arrow and delete the recording. 
Start over again.  

11. Customizing Motion: “Motion and Duration” Tab 

This will take a bit of playing around. If you click on “Specify start 
and end,” you will be able to create motion in your story. You can set 
the duration of time spent on each slide. Again, click on “Preview” to 
see your creation in progress. 

 

12. Transitions 

The other tab on the top of this screen lets you transition from slide 
to slide using different effects. Play around with this until you get 
the feeling you want to convey. Note, after you have made the changes, 
click on “Save” and then “Close” the screen. 

Action Four: Adding Music 



 

13. Select Music  

You can put your favorite music CD in your computer disk player and 
select the music track to embed in your Photo Story. For example, I 
have a favorite Beatles instrumental CD that I find works well with 
many stories I create. There are also some Internet sites that allow 
you to download free music for use in your stories. Note: iTunes does 
not download into this program. 

14. Create Music 

You can also create computer-generated music within this Photo Story 
program. Students LOVE this function. Click on “Create Music” and have 
fun with the different sounds and moods available. 

 

Action Five: Finish Your Project and Save It 



 

14. Saving Your Project 

I strongly recommend saving your story as a project (can be altered) 
before you save it as a final story. Saving your project just saves it 
within the Photo Story program. You can go back and edit, revise, etc. 
Do this first. 

15. Save Your Story for Playback on Computer 

When you are fairly satisfied with what you have done, save the story 
for playback. This allows you to “make the show”—or integrate all of 
the elements together. Toggle the “Save for Playback on your computer” 
and then hit “NEXT.” This action builds your story and plays it back 
for you in a movie format. Be patient. You can save the stories to 
disk or flash drive as well. 

Action Six: Enjoy the Show 

Digital stories are meant to be shared. Hold a special presentation 
for your story or email your story to family and friends.  

 

ELL Tech Recipes 
PODCASTING RECIPE 

 
Serves: 
This technology serves ELL students at all levels. However, Level 1 
(“Entering”) ELLs who are not over the “silent” phase when discovering 
a new language and culture may need more guidance and maybe even some 
cajoling to speak into a microphone. 



 
Ingredients: 
The hardware you’ll need is a computer with a built-in microphone or a 
USB microphone. You may also need an Internet connection. The software 
you’ll need will be GarageBand or Audacity for Mac users and Audacity 
for Windows users. Audacity is a free download. You’ll also want to 
have iTunes, also a free download. 
 

Directions for Cooking 
 

1) Start your software 
2) Record your audio 
3) Edit the audio (add music or remove unwanted material) 
4) Save as MP3 file 
5) If you want to publish, upload to a Web server (every school 

district has their own procedure). 
 
Real quick GarageBand directions: 
 

1) When you open GarageBand click on “new podcast episode” in the 
opening window. 

2) On the top left is a series of five track bars where you’ll 
actually record and mix your tracks. On the bottom left is where 
you can see a timeline of what you are creating or the “loop 
browser”. To start things off, click on either “male voice” or 
“female voice.” 

3) Press the red record icon button in the middle left hand portion 
of your screen to begin recording. Stop recording by pressing the 
space bar. 

4) Have some fun by adding some music/sound effects to your tracks. 
Click on the loop browser (eye-shaped icon in the middle left-
hand portion of your screen) and to start things off, click 
“Jingles.” You’ll see a scrolling menu with lots of options to 
choose from. If you click on a selection, you can hear the track. 
Click on it again to stop playing. If you like the music you’ve 
chosen, click and drag it into the “Jingles” track in the above 
portion of your screen. You’ll see a little green plus (+) sign 
indicating it can be put into that track. 

5) Mixing tracks in GarageBand is easy. To the left of each track is 
a shaded area where you’ll see five small icons under the name of 
the track (“male voice,” “female voice,” etc.). Click on the 
downward facing triangle (far right icon), which shows the track 
volume or pan curve. A shaded blue area will appear below the 
track. Now you can simply raise and lower the small blue circle 
to adjust the track volume. You can raise it up again farther 
along in the track in the same fashion. So if you want to bring 
volume down for one portion, drag the circle down until you want 
to raise it back up. 

6) If that previous step is too much work for you, GarageBand also 
has a great feature called “ducking” which is easy to use. You’ll 



notice that each track has two triangular arrows in the right-
hand portion of the shaded area to the left of the track. When 
you click the top arrow (it will turn yellow), that track will be 
featured (volume will remain high) while other tracks play under 
it. If you click the bottom arrow (it will turn blue), that track 
will be “ducked” or reduce in volume when your vocal (or 
whichever) track plays. 

7) Save your work when have finished editing, click “send podcast to 
iTunes” in the “share” menu. Transfer/upload your online MP3 
flies using FTP (File Transfer Protocol) services. 

 
Real quick Audacity directions: 
When you open Audacity you will see a toolbar at the very top with 
buttons very similar to the function buttons of a tape recorder or 
VCR. To begin recording, click the Record button and speak into the 
microphone. Hit the Stop button when you are finished, and click the 
Rewind button, then Play to hear the recording. 

1) Editing your podcast is similar to cut-and-paste in a word or 
excel document. The cursor tool to select portions of your 
podcast that you would like to edit is in the top left of the 
screen. The other very useful tool in the editing process is the 
zoom in the tool located right below the cursor tool. 

2) Select any part of your podcast using the cursor tool. When a 
portion is selected there will be a shadow over the selected 
portion. You may now cut and paste just like in a word document 
or formulas on a spreadsheet. Under the Edit Menu, you will use 
the basic commands. 

3) You can also add music to your podcast. Make sure you have a 
music file to import. Under the Project menu, select Import 
Audio. A second audio track will appear and you can edit this 
track to a selected portion of the music, adjust the volume, or 
any other effect you choose.  

4) To save the podcast use the FileSave command and Audacity will 
save your podcast as an .AUP file. In order for others to listen 
to your podcast, or to post it on the MyMHCC Portal or iTunes, 
you must save it as an MP3 file. 

 
 

 

 

 

 
 
 
 



 
 
 

ELL Tech Recipes 
TECHNOLOGY RECIPE: Google Docs 

 
Serves: 
Students who are writing and responding to text. Wikis are especially 
helpful for students working on group projects, since they give 
everyone equal access to the same “documents.” 
 
Ingredients:  
It works best on PCs or Macs using Firefox. There have been some 
problems reported with Internet Explorer, but they appear to be 
resolved. If you are using Safari, Google Docs will tell you if you 
are using an unsupported version. 
 

Directions for Cooking 
 

 Log in to <docs.google.com> and take a tour. You can create a 
Google Docs account with any email address. (Google’s email, 
called gmail, is not required.) 

 

 When working with classes, it worked best for us when we created 
the document for each student. We put the student’s name on the 
first line, making that the name of the document. 

 
 
 
 
 
 
 
 
 
 

 Then we invited that student using the “Collaborate” tab. 
 
 
 
 
 
 



 
 
 
 
 
 

 When we clicked on the “Invite collaborators” button, it allowed 
us to send a message to that student giving him or her the link 
to the document. This was helpful for those who did not have 
Google Docs accounts because it simplified the process of 
creating a Google Docs account.  

 

 After we invited the individual student for whom we were creating 
a document, we pasted the list of all the students in the group 
into the collaborators’ box. After we clicked on the “Invite 
collaborators” button, we chose not to send messages to all of 
them. 

 

 For a teacher with multiple classes using Google Docs, grouping 
documents into class groups is important. 

‐ First, create a new folder under the “New” pull-down menu. 
 

‐ Then select the documents you want to group together. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



- Then use the “Add to folder” pull-down menu to select the 
correct folder. 

 

 

 

 
 
 

ELL Tech Recipes 
RECIPE FOR Wikispaces 

 
Serves:  
Students who are writing and responding to text. Wikis are especially 
helpful for students working on group projects since they give 
everyone equal access to the same “documents.” 
 
Ingredients:  
Mac running Firefox (Does not work well in Safari) or PC running 
Firefox or Internet Explorer  
 

Directions for Cooking 

 Connect to www.wikispaces.com 
 Take a tour. Short videos of how to create and use a wiki will 

get you started quickly and easily. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 In less than 15 minutes you can have a wiki that your students 
can easily use to post their writing and get and give feedback. 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 To add students, you can invite them by clicking on Manage 
Space>Invite People. You can also send a list of students, their 

 



email addresses, and passwords to the people who run Wikispaces 
and they will add all the students. This allows you to know 
students’ passwords, something that often comes in handy.  

 

 One nice thing about Wikispaces is they give free accounts 
without any ads to schools. School wikis are private, so teachers 
control who can get into the wiki. 

 

 


